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Module 5, Lesson 2 

A line in the sand 
 
The ever-changing map of  the world reflects the forces of  conflict and cooperation among 
nations and peoples of  the world. In this activity, you will explore one of  the first boundary 
changes of  the twenty-first century — the creation of  a new border between Yemen and 
Saudi Arabia. After more than 60 years of  conflict, the two nations signed the historic 
boundary agreement in June 2000. Using data from the Treaty of  Jeddah, you will create a 
map reflecting the treaty’s territory and analyze underlying physiographic and cultural 
considerations that influenced the location of  the boundary. 
 
Step 1: Open a map document 
	
1. Double-click the ArcMap icon on your computer’s desktop. 
	
2. When the ArcMap start-up dialog box appears, click Browse for more... 
 

 
 
 
3. Navigate to the Module 5 folder (OurWorld2\Mod5) and choose Region5.mxd (or 

Region5) from the list. 
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4. Click Open. 
 

When the map document opens, you see a shaded relief  map with the Arabian 
Peninsula outlined in red. 
 
5. Stretch your ArcMap window so that it fills most of your screen. 

 
 

Step 2: Identify countries that border the Arabian Peninsula 
 

1. Click the Bookmarks menu and select Arabian Peninsula. Now the Arabian 
Peninsula fills the view. 
 

2. Look in the Table of Contents for a layer called “Neighbors - outline.” Click the 
box to the left of the layer name to turn it on. 
 

3. Hover the mouse pointer over the map to display the country names. 
 
 
 
 

Q1       What countries border the Arabian Peninsula to the north? 
 
Step 3: Investigate the physical characteristics of the Arabian Peninsula 
 
The map on your screen is a shaded relief  map. It depicts landforms such as mountain 
ranges, valleys, plateaus, and plains.  
 
 
Q2       Is any part of the Arabian Peninsula mountainous? 
 
Q3       If so, where are the mountains located? 
 

1. Click the plus sign next to Water in the Table of Contents to expand this group of 
layers. 

2. Turn on the Bodies of Water and Streams layers. Then display them by checking 
the box next to Water. 

 
Most of  the streams you see on your map are intermittent, which means that they are dry 
during some parts of  the year. 
  

Answers to questions in this activity should be recorded on the answer sheet. 
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Q4  Are there any parts of the Arabian Peninsula that do not have any water at all? If so, 

where are these regions? 
 
Q5  Do you see any relationship between landforms and the availability of water? 
 

3. Turn off the Streams layer and observe the distribution of permanent bodies of 
water on the Arabian Peninsula. 

4. Click the Zoom In tool. Click and drag a small box around an area of blue 
dots. Now you can see the bodies of water more closely. 

 
Q6  Describe the bodies of water in terms of their connectedness or disconnectedness. 
 

5. Click the Previous Extent button to return to your view of the entire peninsula. 
6. Turn off the following layers:  

 Water,  
 Under Basemap 

o Arabian Peninsula — outline 
o Neighbors — outline  
o Shaded  Relief (you may need to scroll down in the Table of 

Contents) 
 

Your map display should look like this:  
 

 
 
 

7. Collapse the Water group. Expand the Annual Precipitation layer and turn it on. 
 
Amounts of  rainfall are given in millimeters in the map document. The following table 
shows what some measurements in millimeters would be equivalent to in inches (25.4 mm = 
1 in.). 
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mm 100 200 300 400 500 600 700 
inches 3.9 7.9 11.8 15.7 19.7 23.6 27.6 
 
Q7  A desert is defined as a place that gets less than 10 inches of rain per year. How many 

millimeters equal 10 inches? 
 
Q8  Based on the amounts of rainfall displayed on the map, do you think there is much 

farming on the Arabian Peninsula? Explain. 
 
Q9  Approximately what percentage of the Arabian Peninsula is desert? 
 

8. Turn off Annual Precipitation. Turn on and expand the Temperature layer group. 
Turn on Temp: Sept. – Nov. 

 
Temperatures are given in degrees Celsius in the map document. The following table shows 
what some measurements in degrees Celsius would be equivalent to in degrees Fahrenheit. 
 
ºC 5 10 15 20 25 30 35 40 
ºF 41 50 59 68 77 86 95 104 
 
Q10  What is the approximate range of temperatures across the Arabian Peninsula during 

September through November? 
 
The three layers below “Temp: Sept.- Nov.” display temperature information for the periods 
December–February, March–May, and June–August. 
 

9. Turn the temperature layers on and off one at a time to see the change of 
temperatures on the Arabian Peninsula through the four seasons. 

 
Q11  Which season is the hottest? 
 
Q12  What is the approximate range of temperatures across the Arabian Peninsula during 

the hottest season? 

L2 
10. Turn off the Temperature group. Turn on the Ecozones layer and expand its 

legend. 
 
Q13  What relationship do you see between the Arabian Peninsula’s ecozones and its 

patterns of landforms, precipitation, and temperature? 
 
Q14  Use your answers from previous questions and turn different layers on and off to come 

up with three observations for each physical characteristic in the table on the answer 
sheet. 

 
Q15  In your opinion, which of the region’s physical characteristics would be considered 

“valuable” in a boundary decision? Explain. 
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Step 4: Investigate the population characteristics of the Arabian Peninsula 
 
The population of  the Arabian Peninsula is approximately 57 
million. The majority of  this population lives in Saudi Arabia (27.5 
million) and Yemen (22 million). The remaining 7.5 million live in 
Oman, the United Arab Emirates, and Qatar. 
 

1. Turn off Ecozones. Turn on the “Arabian Peninsula – 
names” layer. This layer identifies the countries by 
name but does not show their borders (you will explore 
the borders of these countries later in the activity).  
 

2. Turn on the Major Cities and Agriculture layers. Expand the Agriculture legend to 
see the types of agricultural activity on the Arabian Peninsula. 

 
Q16  What is the principal agricultural activity on the peninsula? 
 
Q17  Based on what you now know about the physical characteristics of the region, why do 

you think the agricultural activity is so limited? 
 

3. Turn on and expand the Population Density layer. The population is displayed as 
number of people per square kilometer. 
 

Q18  How does Yemen compare to the rest of the Arabian Peninsula in population density? 
 
Q19  Describe the overall population density of the Arabian Peninsula. 
 

4. Turn off Population Density. Make sure Agriculture is still turned on. 
 
5. Turn on the Water layer, expand it, and turn on Springs. Turn off Bodies of Water. 

The Springs layer shows the locations of springs and water holes. 
 

 
 
Q20  Speculate about the ways water is most commonly used at these springs and water 

holes. 
 
Q21  Use your answers from Q16–Q20 and analysis of the maps to list two observations for 

each population characteristic in the table on the answer sheet. 
 
Q22  If an international boundary were to be drawn across some part of the Arabian 

Peninsula, how would these population characteristics influence the perception of 
certain regions as being more valuable than others? 
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Step 5: Investigate the Empty Quarter 

1. Turn off Springs and turn on Roads. Expand the Roads legend. 
 
Take note of  the large area with practically no roads in the south-central part of  the 
peninsula. This region is called the Rub´ al-Khali and is also known as the Empty Quarter. 
Saudi Arabian borders along with its southern neighbors cross this region. 
 

2. Turn the following layers on and off so you can observe the characteristics of the 
Empty Quarter: Streams (under Water), Population Density, Agriculture, 
Ecozones, Temperature (by season when expanded), and Annual Precipitation. 

 
Q23  List two observations on the physical characteristics of the Empty Quarter and two 

observations on its population characteristics. 
 
Q24  What difficulties would an area like this present if an international boundary must 

cross it? 
 

3. Right-click the Arabian Peninsula data frame in the Table of Contents and choose 
Collapse All Layers. 
 

4. Right-click Arabian Peninsula again and choose Turn All Layers Off. Then turn 
the following layers back on: Major Cities, Arabian Peninsula - names, and 
Basemap. 
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5. Ask your teacher for instructions on where to save this map document and what 
name to give it. Click the File menu and Save As to navigate to the desired folder 
and rename the map document. 
 

Q25  Write the map document’s new name and location. 
 

6. If you will be stopping here and continuing the lesson at a later time, click the File 
menu and Exit. 

 
 
Step 6: Explore Saudi Arabia’s southern boundaries 
 

1. If you exited at the end of the last section, start ArcMap, navigate to the folder 
where you renamed and saved Region5, and open the map document. 
 
 

2. Right-click the Saudi Arabia Southern 
Boundaries data frame and click Activate. 
Expand the data frame legend. 
 

3. Turn on the 20th Century Boundary layer. This 
layer reflects the boundary agreements Saudi 
Arabia made with most of its southern neighbors 
at the end of the twentieth century. 
 
 

Q26  Are the boundaries what you expected them to be? 
 
Q27  Which boundary remained unsettled? 
 
 
According to international boundary expert Richard Schofield, this boundary was “the last 
missing fence in the desert.” The only part of  the boundary that was mutually agreed upon 
was the western area adjacent to the Red Sea. Over the years, the boundary has shifted. You 
will now add layers that reflect some of  the major boundary changes. 
 

4. Click the Add Data button. Navigate to the module 5 Data folder and look in 
the LayerFiles folder (OurWorld2\Mod5\Data\LayerFiles). Hold down the Shift key 
and click once on each of the following file names: Yemen1.lyr, Yemen2.lyr, and 
Yemen3 .lyr. Click Add. 
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5. Turn off Yemen2 and Yemen3 for the moment and look at the red line of Yemen1. 
 
 

This line represents the boundary between Yemen and Saudi Arabia established by the 
Treaty of  Ta’if  in 1934. It is the only part of  the boundary that both countries recognized at 
the turn of  the twenty-first century. 

 
6. Turn on Yemen2. 

 
The green line of  Yemen2 represents the Saudi–Yemeni border recognized by Yemen at the 
end of  the twentieth century. It is based on lines established when a portion of  Yemen called 
the Aden Protectorate was under British control in the early twentieth century. Most maps 
used these lines to delineate the extent of  Yemen prior to 2000. This boundary was not 
recognized by Saudi Arabia. 
 

7. Turn on Yemen3. 
 

This purple line represents the Saudi–Yemeni border claimed by Saudi Arabia at the end 
of the twentieth century. It is based on lines established by the Saudis in the mid-1930s. 
This line was still being used on Saudi Arabian maps to represent the boundary in the 
1990s. 
 

8.  Click the Zoom In tool. On your map, click the label Yemen. Now the map is 
centered on the country of Yemen. 

 

9.  Click the Fixed Zoom In button two or three times until the country of Yemen 
fills the view. 
 

Q28  What does the area between the green and purple lines represent? 
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10. Turn on Agriculture and expand its legend. 
 

Q29  What is the principal economic activity of the regions in dispute? 
 

11. Turn off Agriculture and turn on and expand Population Density. 
 

Q30  Describe the population distribution in the disputed territory. 
 
If  you were asked to settle the boundary dispute between Saudi Arabia and Yemen, where 
would you draw the line? You will now draw a proposed boundary between Saudi Arabia and 
Yemen. 
 

12. Make sure the Draw toolbar is displayed. If you don’t see it, right-click in the gray 
space to the right of the Help menu to display the toolbar list and click Draw. A 
good place to dock the Draw toolbar is at the bottom of the ArcMap window. 
 

13.  On the Draw toolbar, click the drop-down arrow next to the Rectangle tool 
and choose the Line tool. 
 

14. On your map, click the eastern end point of the red boundary line (this is the 
boundary that both countries agree on). Proceed eastward (to your right) and 
click a proposed boundary line. Double-click when you get to the end of your 
boundary. 
 

Now you have an additional black line that extends from the red line to Oman. 
 

15.  Make sure the Select Elements tool is now active. Click anywhere on the 
map away from the line you drew to make the blue selection box disappear. 
 

 
 
Step 7: Draw the Saudi–Yemeni boundary 
 
In June of  2000, Saudi Arabia and Yemen signed the Treaty of  Jeddah, which settled their 
65-year-long boundary dispute. The boundary agreement had three parts. The first part of  
the treaty reaffirmed agreement on the 1934 Ta’if  line (the Yemen1 line). The agreement did 
say, however, that the line would be amended in any place where it cuts through villages. 
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1.  Click the Zoom In tool. 
Zoom to the area of the Ta’if 
line (red line) by dragging a box 
around it. 
 

2.  Click the Add Data button. 
Navigate to the module 5 Data 
folder and look in the 
LayerFiles folder 
(OurWorld2\Mod5\Data\LayerFi
les). Select Cities and 
Towns.lyr. Click Add. 
 
 

 
 
 

Q31  Does the red line go through any cities or towns? (You may need to zoom in again.) If 
yes, approximately how many does the boundary pass through? 

 
Q32  How would you decide on which side of the town to put the boundary? Remember, this 

decision would determine whether the residents of that village would be citizens of 
Saudi Arabia or Yemen. 

 
The second part of  the Treaty of  Jeddah determined the new boundary from the end of  the 
red line to the border with Oman, 500 miles to the east. The treaty did not actually draw the 
line but gave its starting and ending points and points in between as latitude/longitude grid 
coordinates. You will now plot these points on your map to locate the new boundary line. 
 

3. Turn off Cities and Towns and Population Density. 
 

4. Click the Bookmarks menu and choose Yemen to zoom out to the entire country. 
 
 

You will need your own layer for holding the data you will plot. You will make a copy of 
the Boundary Template layer, which has no features, for this purpose. 
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5. Right-click the Boundary Template layer. Point to Data and click Export Data. 
 

6. Click the Browse button in the Export Data dialog box. The Saving Data dialog 
box is displayed. You will be saving a feature class, so click the “Save as type” 
drop-down list and choose “File and Personal Geodatabase feature classes.” 
 

 
 

7. Use the “Look in” drop-down menu to navigate to the MiddleEast geodatabase 
(Mod5\Data\MiddleEast.gdb). Name the file ABC_Yemen4, where the letters ABC 
are your initials. Click Save and then click OK in the Export Data dialog box. 
 

 
 
 

8. Click Yes to add the exported data to the map. Check the box to turn on 
ABC_Yemen4. 
 

9. Right-click the Boundary Template layer and click Remove to remove it from the 
map.  
 

You will use tools on the Editor toolbar to plot the latitude and longitude coordinates for the 
new Saudi–Yemeni boundary. 
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10.  Click the Editor Toolbar button to turn on the Editor 
toolbar. Dock the toolbar above the map. 
 

11. Click the Editor menu on the Editor toolbar and choose 
Start Editing.  
 

 
 

12. The Create Features Window will appear to the right of 
the map view. Click ABC_Yemen4 on that list. At the 
bottom in the Construction Tools section on the Create 
Features tab select line. 

 
13. Right-click anywhere in the map and choose Absolute 

X,Y.  
 

14. The first point you will enter is 52 degrees longitude, 19 
degrees latitude. 
 

You see a red square called a vertex appear at the border with 
Oman. Your cursor is attached to the vertex with an elastic line. 
As you move your cursor around the map without clicking, the 
line changes. The elastic line tells you that the new line feature 
you are creating is not yet finished. 
 

15. To enter the remaining longitude and latitude points 
determined in 2000, consult the table below (points 2–
17). For each point, you must right-click on the map, 
choose Absolute X,Y, and enter the coordinates from 
the table. Enter all seventeen points from the table 
now. 

Point Longitude Latitude Point Longitude Latitude 

Point Longitude Latitude Point Longitude Latitude 
1 52 19 10 46.37 17.23 
2 50.78 18.78 11 46.1 17.25 
3 49.12 18.61 12 45.4 17.33 
4 48.18 18.17 13 45.22 17.43 
5 47.6 17.45 14 44.65 17.43 
6 47.47 17.12 15 44.57 17.4 
7 47.18 16.95 16 44.47 17.43 
8 47 16.95 17 44.37 17.43 
9 46.75 17.28       

 
 
If  you make a mistake entering a point, click the Edit Sketch Properties tab in Construction 
Tools.  Click on the error and correct it.  
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16. When you are satisfied that you have entered all of the points correctly, right-click 
anywhere on the map and choose Finish Sketch. The completed line is 
highlighted in blue. 
 

17. Click the Editor menu on the Editor toolbar and choose Save Edits. 
 
Q33  Does the new line seem to favor Yemen or Saudi Arabia? Explain. 
 
 
Step 8: Add the maritime portion of the boundary 
 
The third and final part of  the Treaty of  Jeddah clarified the maritime boundary between 
Saudi Arabia and Yemen. A maritime boundary defines the offshore limits of  a country. It 
too was defined by a series of  latitude/longitude grid coordinates. 
 

1. Follow the procedure you just used to draw the land border to now map the 
maritime boundary between Saudi Arabia and Yemen. 
 

Point Longitude Latitude 

Point Longitude Latitude 

1 42.77 16.40 

2 42.15 16.40 

3 41.78 16.29 
 

2. Finish the sketch. Click the Editor menu and choose Stop Editing. Click Yes to 
save your edits. 
 

3.  Click the Editor Toolbar button to turn off the toolbar. 
 

4.  Click the Fixed Zoom Out button twice. 
 
Q34  What body of water does the maritime boundary traverse? 
 
Because ArcMap randomly selects a color for a new layer, you need to change it. You will 
also give the layer a more descriptive name. 
 

5. Click the name of the ABC_Yemen4 layer two times slowly and change the name 
to 2000 Boundary. Right-click the line symbol and choose a dark blue color. 
 

Q35  How does the actual boundary established by the Treaty of Jeddah compare with the 
boundary you drew earlier (black line)? 

 
Q36  Write three observations about the boundary line created by the Treaty of Jeddah (turn 

on Agriculture and Population Density as needed). 
 

6. Save your map document. 
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Step 9: Define the pastoral area 
 
The Treaty of  Jeddah included additional provisions about the new Saudi–Yemeni boundary. 
One of  these was the creation of  a “pastoral area” on either side of  the boundary.  
Shepherds from either Yemen or Saudi Arabia are allowed to use the pastoral area and water 
sources on both sides of  the border according to tribal traditions. The treaty declared that 
the pastoral area extends 20 kilometers on either side of  the border. You will now map the 
20-kilometer pastoral area. 

2 
Q37  How many miles is 20 kilometers? (1 kilometer = 0.6214 miles) 
 

1. ArcToolbox is where you can access many ArcGIS tools that work on your data. 
You will use the Buffer tool to draw the 20-kilometer zone around the boundary 
line. 
 

2. Click the Geoprocessing menu, select Buffer. From the Input Features drop-down 
list and choose 2007 Boundary. 
 

 
 

3. Name the output feature class ABC_Yemen4_Buffer1. If the destination is not 
listed, click the browse button and navigate to Mod5\Data\MiddleEast.gdb. 
 

4. For Distance, choose Kilometers from the Linear unit drop-down list, and then 
type 20 in the box on the left as the buffer distance. 
 

 
 

5. Click OK. After the buffer is completed, close the Buffer window if it’s open.  
 

6. Add the buffer layer to the map if it isn’t added automatically. 
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7. Click the Clear Selected Features button to clear the selection. 
 
 

Q38  In which portion of the Saudi–Yemeni border will the pastoral area be most  
significant? Explain. 

 
Q39  Why do you think the Treaty of Jeddah created a pastoral area? 
 
 
 
Step 10: Create a map of the Arabian Peninsula 
 
Before you print a map of  the Arabian Peninsula, you need to clean it up. 
 

1.  Click the Select Elements button. Click the boundary line you first drew (it’s 
black and doesn’t have the buffer around it). A dashed box appears to show the 
line is selected. Press the Delete key. Your line disappears from the map. 

 
2. Go to the Arabian Peninsula bookmark. 
 
3. Decide what layers you want to display on your map. Include the following layers: 

• Major Cities 
• 2000 Boundary 
• Yemen1 
• 20th Century Boundary 
• Arabian Peninsula - names 
• Arabian Peninsula - area 
• Neighbors – countries 
 

4. From the File menu, click Page and Print Setup. Follow your teacher’s 
instructions to select the correct printer name. Be sure to check the “Use Printer 
Paper Settings” box and the “Scale Map Elements proportionally to changes in 
Page Size” box. In the Paper section, choose the Landscape orientation. Click 
OK. 
 

5. From the File menu, click Print. Click OK. 
 

6. Save your map document. 
 

7. From the File menu, click Exit. When asked if you want to save your changes, 
click No. 

 
In this lesson, you explored physical and population characteristics of  the Arabian Peninsula. 
After analyzing this data, you explored boundary issues in this region and plotted the new 
Yemeni–Saudi boundary established by the 2000 Treaty of  Jeddah. 


